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I.  INTRODUCTION 
 
 
According to the Oxford Classical Dictionary, 'Musaios' was a mythical singer connected to 
Orpheus, who taught oracles, and the same name was held by the late 5th century A.D. author of 
Hero and Leander, "a poem of some competence and romantic grace". 
 
The authors of MUSAIOS, as graduate students at the University of California, were the authors 
of the now-forgotten SEARCHER and PHAROS dating back to the late 1980s.  When C++ 
became widespread during the early 1990s, it was decided to completely rewrite the program 
without reference to what had been done before.  MUSAIOS was launched and became 
generally available in February 1993.  SEARCHER and PHAROS remain the property of the 
Regents of the University of California, but are no longer available or supported and became 
obsolete long ago.  They were last maintained during the days of Windows 3.1. 
 
Over nearly 1000 individuals and institutions have registered MUSAIOS since it was launched.  
You may feel free to distribute copies of the Musaios to your colleagues and friends, although, if 
you have registered the program and obtained a registration number, of course you may not give 
that registration number to others. 
 
Version 2010 ends the former dependence of Musaios on the WinGreek font, and can use 
any Unicode font with Polytonic Greek characters that happens to be installed on your 
computer.  A new "Unicode Font Explorer" will tell you which fonts are available, and 
allow you to select one for your use.  The Palatino Linotype typeface, which is the most 
widely distributed font with Windows is used as the default. 
 
 



II.  REGISTRATION 
 
After receiving a copy of MUSAIOS from whatever source, you must register and pay 
within 30 days, or else de-install the product from your computer and cease using it. 
 
The registration number scheme has been changed from earlier versions of Musaios.  
Please send E-mail to ddumont@musaios.com to obtain a new registration number if you 
are already registered. 
 
If you are not already registered: 
 
To obtain a registration number for Musaios 2010 you can send $80 in U.S. funds to: 
 
Musaios c/o Darl J. Dumont  
840 Oneonta Drive 
Los Angeles, California 90065-4125 
USA 
 
Checks should be payable to MUSAIOS, and must be drawn on a U.S. bank, with U.S. style 
magnetic letters.    
 
Be sure to include the exact name you would like the program to be registered to.  It will be 
displayed every time you enter the program. 
 
Alternatively, you can FAX credit card information to +323 427 4792, [USA number], including 
cardholder name, billing address for the credit card, expiration date, and your E-mail address in 
case there are problems or questions. 
 
The above price of $80 covers registration of electronically-distributed copies, and does not 
include mailing of a CD-ROM.  If a CD-ROM is to be shipped, the registration fee is $95 postpaid.  
The CD-ROM now contains extra features additional to those available on the 
downloadable version, so it is recommended you obtain the CD-ROM version. 
 
In addition to the Musaios program as included on the electronic version, the CD-ROM 
version also includes keyword-in-context concordance files for TLG E and PHI 5.3 authors, 
and a Latin Word Index for PHI 5.3 modelled on the word index included with TLG E. 
 
We can be reached by E-mail on Internet at ddumont@musaios.com. 
 



 
 
III.  HARDWARE REQUIREMENTS 
 
MUSAIOS 2010 does not have any specific hardware requirements beyond those required to run 
the Microsoft Windows operating system, except of course that a CD-ROM drive is required to 
read the TLG and PHI discs.   
 
Any computer that can run Windows XP, Windows Vista, or Windows 7 can run Musaios. 
 
 
 
IV.  SOFTWARE REQUIREMENTS 
 
MUSAIOS 2010 runs under Microsoft Windows XP, Windows Vista, and Windows 7 on PC-
compatible computers.  It will run under both 32-bit and 64-bit versions of each of these operating 
systems. It will NOT run on Windows 95, Windows 98, or Windows ME. 



 
V.  INSTALLATION OF MUSAIOS FROM THE CD-ROM 
 
If there is a pre-existing installation of Musaios 2002A it need not be removed.  Musaios 
2002 and 2010 can co-exist on the same computer. 
 
Put the Musaios Installation CD-ROM in your CD-ROM drive. 
 
If your computer is set up to "Auto-Run" CD-ROMs, the installation program will start to run 
automatically.  If not, navigate to your CD-ROM drive using Windows Explorer and execute 
SETUP.EXE in the root drive of the Musaios Installation CD. 
 
From the first screen, "Welcome to the Musaios 2010 Setup Wizard", click Next to proceed to this 
screen: 
 

 
 
The Musaios Program and Instruction Manual by themselves are relatively tiny and only occupy 1 
MB on your hard drive.  The TLG-E Concordances occupy 437 MB, the PHI 5.3 Concordances 
occupy 49 MB, and the PHI 5.3 Latin Word Index occupies 8 MB.  If you choose all features, the 
total space occupied is approximately 1GB, which is small enough that for computers purchased 
within the last several years with a reasonable amount of unused space remaining on the hard 
drive, this should not be a matter of any concern at all. 
 
Next you can choose the folder where Musaios will be installed.  Normally you will accept the 
default value unless you do not want the program installed on your C: drive.  You may install it on 



a drive other than C: using this screen if that is desired.  For computers configured to have more 
than one user login you may choose whether Musaios is installed available to all users, or only to 
the user currently logged in: 
 

 
 
 
The installation will take a few minutes, possibly three to ten minutes depending on your 
computer and how many features you have chosen to install. 
 



 
 
 
After installation, under the Programs or All Programs item in your Start Menu, you will see a 
folder labeled Musaios 2010 within which are items to launch the Musaios Program, and to view 
this instruction manual: 
 

 



 



VI.  GREEK FONTS – THE UNICODE FONT EXPLORER 
 
Windows XP, Windows Vista, and Windows 7 have all shipped with Unicode fonts including some 
fonts with support for Polytonic Greek.  For previous versions of Musaios, the WinGreek font had 
to be installed to view Greek texts.  The WinGreek font is no longer required;  in fact its use with 
Musaios is no longer supported.  The first time Musaios is launched, the Palatino Linotype font is 
automatically selected for display of texts.  Palatino Linotype is the most widely distributed font for 
Windows that includes Polytonic Greek characters, and is shipped with Windows and installed by 
default. 
 
To change the Unicode font that Musaios uses to display Greek text, or to see which fonts with 
Polytonic Greek support have been installed on your system, from the Options Menu in 
Musaios, choose Unicode Font Explorer. The program will scan all installed fonts on your 
computer, and the left listbox will show you which fonts with Polytonic Greek characters are 
available.  The numbers in brackets are the total number of Polytonic Greek characters included 
in each font. 
 

 
 
As you change the highlighted font in the left listbox, a short Greek phrase will be rendered in that 
font, under the left listbox, to give an idea of the appearance of the font. 
 
To choose a new font for Musaios to use, after selecting the font in the left listbox, click on the 
Add> button.  The standard Windows dialog for font selection pops up, allowing further 
refinement of font size and style for the selected font: 



 
 
When you have finished your selections, click OK to close the listbox, then click on Close in the 
Unicode Font Explorer dialog box.  Your font will now be selected for display of texts in Musaios.  
The settings will be remembered for future Musaios sessions, until you change it again 



VII.  THE POLYTONIC GREEK KEYBOARD 
 
Keyboards for Polytonic Greek are also available built in to Windows as part of Windows XP, 
Windows Vista, and Windows 7, and can be installed using the Windows control panel.  Once 
installed, the Greek Keyboard can be used to enter Greek search strings in Musaios, as well as 
generally to enter Polytonic Greek text in other programs such as Microsoft Word. 
 
For further information, use your Windows Help function to search for help on "Input Languages" 
and 'Language Bar".  You can also search the Internet for instructions and examples of how to 
set this up in languages other than English. 
 
This Polytonic Greek keyboard need not be set up immediately to use Musaios.  You can 
use your default keyboard and enter Beta Code characters if that standard is familiar to 
you [see section XXI, below].  Musaios will detect which character set is in use and search 
accordingly. 
 
Windows XP 
 
To install the Greek keyboard layout in Windows XP, follow these steps:  
 
1.In the Windows XP standard Start menu, click Start, and then click Control Panel.  
In the Windows XP classic Start menu, click Start, click Settings, and then click Control Panel. 
2.Double-click Regional and Language Options. 
3.Click the Languages tab, and then click Details under "Text Services and Input Languages".  
4.Click Add under "Installed Services", and then click Greek language and the Greek keyboard 
layout you want to use for that language.  
5.To configure the settings for the Language bar, click Language Bar under "Preferences".  
 
Windows Vista 
 
1. Open Regional and Language Options by clicking the Start button, clicking Control Panel, 
clicking Clock, Language, and Region, and then clicking Regional and Language Options.  
2. Click the Keyboards and Languages tab, and then click Change keyboards. 
3. Under Installed services, click Add. 
4. Double-click Greek language, double-click the text services you want to add, select the text 
services options you want to add, and then click OK. 
 
Windows 7 
 
1. From the start menu, choose the Control Panel, then choose Region and Language.  
2. From the Region and Language dialog, choose the Keyboards and Languages tab. 
3. Choose the Change Keyboard button, which will bring up the Text Services and Input 
Languages dialog. 
4. From the Text Services and Input Languages dialog, select the General tab, then in the 
Installed Services section of the General tab, choose Add. 
5. Choose Greek from the resulting Add Input Language screen, expand the Greek options by 
clicking on the + sign next to Greek, and in the Keyboard section, choose Polytonic Greek. 
6. The language bar settings which determine how you select between keyboards are controlled 
by the Language Bar tab of the Text Services and Input Languages dialog. 
 
 



 
The following link [valid at the time of writing of this manual] has some helpful information on 
setting up the Windows Polytonic Greek keyboard: 
http://www.biblicalgreek.org/links/fonts/keyboard.html 
 



VIII.  INITIAL CONFIGURATION OF MUSAIOS 
 
The first time you run MUSAIOS, the program will detect that there is no configuration 
information.  You will then be prompted to enter the drive letter of your CD-ROM drive.  
Afterward you are shown two screens of default settings. If you don't find these self-
explanatory just click on the OK button to accept the defaults.  You can always come back 
and change them later. 
 
The Musaios program will scan your computer to see which drives are marked as being of type 
CD-ROM.  These are displayed on the screen.  If any are found, the one with the lowest letter will 
be offered as the default choice: 
 

 
 
The following two screens may be edited later at any time via the Options menu. 
 
The first of the two screens gives you the chance to specify file paths.  You may later want to 
copy certain files from the CD-ROMs to on your hard drive.  However, this is an advanced 
technique and you  probably should delay taking up space on your hard drive until you have an 
actual need to improve performance for a specific author. 
 
The second of the two screens concerns user preferences.  If you select "Always Run 
Maximized", whenever you start MUSAIOS it will be expanded in size to take up the entire 
screen.  The rest of Windows is still running beneath MUSAIOS.  You are still free to resize the 
window later using the standard Windows techniques. 
 



IX.  OVERVIEW OF OPERATION 
 
There are several ways to perform almost every operation in MUSAIOS.  These include via 
the menu system using the mouse, via the menu system using the keyboard, via function 
and control keys, and via the icons on the "tool bar".  It is easiest to start out using the 
menu system via the mouse and/or keyboard and learning the alternatives later.  Note that 
as each menu item in a drop-down menu is highlighted, the "status bar" at the bottom of 
the screen explains its function. 
 
Our "beta sites" were given no documentation at all and yet seemed to have no problem learning 
the program intuitively from the menu system.  We have tried to conform closely to standard and 
mainstream Windows practices, so if you are already familiar with a few other Windows 
applications you should have no problem at all.   
 
You will also note that once you have opened up a window for a specific text, the menu 
system expands considerably, adding items that only make sense if there is a text window 
open.  That is why you may see references in this manual to menu items that you might 
not be able to find.  Just open up a text window and the missing menu items will appear. 



 
X.  OPENING AND USING TEXT WINDOWS 
 
If you open up the FILE menu, you will see that the first four menu items are:  PHI 5, PHI 6/7, 
TLG, and "Auto Select".  There will be a checkmark next to one of these four items.   If you have 
not copied files from the CD-ROMs to your hard drive, and you have only one CD-ROM 
drive, leave Auto Select checked on the FILE menu.  This means that whatever CD-ROM 
you happen to have in your CD-ROM drive will be automatically selected for reading.  If 
you have PHI's Founding Fathers CD-ROM, leave Auto Select checked. 
 
(Once you have copied files from more than one of the CD-ROMs to your hard drive, you require 
a way to specify which set you are interested in without having to put the specific CD-ROM in the 
drive each time.  That is why this option is provided.) 
 
Put the CD-ROM of interest to you in your CD-ROM drive, and use the OPEN menu item in the 
FILE menu to open text windows.  After you select OPEN, the author list for the CD-ROM 
will be shown.  Type in the first few characters of the name of the author of interest to scroll that 
part of the author list into view.  Use the mouse or the down-arrow key to highlight the author you 
want.  Click on OK or hit return, and you will be shown a list of works for the author, provided 
there is more than one work.  Repeat this process for the work, and a text window will open up, 
displaying the beginning of the work. 
 
You can use the PAGE UP, PAGE DOWN, UP ARROW, DOWN ARROW, HOME, and END keys 
to move through the work.  You can click on the different parts of the scroll bar, or drag the scroll 
bar thumb to move through the work.  MUSAIOS responds to scrollbar actions identically to Word 
for Windows.   
 
You can also use the JUMP menu to choose a specific location within the work. 
 
You will notice a little pointer >> at the left of each open text window, which always points 
to one of the lines of the text.  The location information at the bottom of the text window 
always specifically describes the line at which the pointer is aimed.  Use the up arrow key 
and down arrow key to move the pointer. 
 
If you have more than one text window open at a time, you may arrange them using items in the 
WINDOW menu.  Available are CASCADE, TILE VERTICALLY, TILE HORIZONTALLY, CLOSE, 
and CLOSE ALL, which are self-explanatory (just open three text windows and try them all). 
 
The NEXT WINDOW option on the WINDOW menu cycles through your open text windows, 
bringing each to the top sequentially. 



 
XI.  EXPORTING TEXT TO OTHER PROGRAMS 
 
With a text window open there are two ways to export text to another program, through the 
Clipboard (also known as "cut and paste") and by saving text to a file. 
 
For any open text window, you may select text by dragging the mouse, or by using shift-
up-arrow and shift-down-arrow in the standard Windows manner (refer to your Windows 
manual if this is unclear).  Selected text is shown as white-on-black instead on black-on-
white. 
 
To export text via the Clipboard, use the COPY item on the EDIT menu to export the text to 
the Windows clipboard.  To save the selected text to a file, use the EXPORT item on the EDIT 
menu then enter the filename you wish to use.  If the text was being displayed in normal 
mode, the text will be exported in Rich Text Format (RTF).  In order to paste this text into a 
program or open the saved file, the other program must be able to understand RTF.  At this 
time Microsoft Word is the best example of this type of program.  WordPerfect claims to do 
this, but does not seem to work correctly with Musaios or any other program.  If the text was 
being displayed in Beta Code, the text will be exported in Text format.  Almost any 
program which works with textual data should be able to accept text from the Clipboard or 
open a file in this format. 
 
Starting with MUSAIOS 2001 A, much more text can be exported than before to the Windows 
Clipboard, or a file in Rich Text Format (RTF).  Formerly you could only select for export the text 
visible on the screen.  Now you can select about 100 lines for export.  In this we have followed 
the lead of Pandora (software for the Macintosh).  The limitation remains at this level at the 
specific request of TLG because of concerns about facilitating copyright infringement. 
 
 
 
 
 
XII.  DISPLAYING BIBLIOGRAPHIC DATA FROM THE TLG AND LATIN CANON 
 
TLG: 
 
When you are viewing a TLG text, at any time you can choose "View Bibliographic Canon 
Information for This Work…" from the View menu.  A screen will pop up with information 
about the author in the top half of the screen and bibliographic information about the particular 
text in the bottom half.  You may tab to either of these text segments and then click with the right 
button of your mouse to copy the data into the Windows clipboard for pasting into other 
applications.  (A menu will pop up after your right-click.) 
 
PHI Latin Canon: 
 
Using the Open item on the File menu, type in Latin Canon to scroll the listbox to near the 
end.   Select Latin Canon and you may search and browse this text file to find the Author 
and Work you are looking for.  (The format is less sophisticated than the TLG Canon). 



 
XIII.  USING THE CONCORDANCE VIEW 
 
A "Concordance View" can be opened for Latin [PHI 5.3] and Greek [TLG E] authors if you 
have installed Musaios from the CD-ROM and chosen to install the concordance files.    
Once you have installed the plug-ins, you may rapidly shift back and forth between the Text View 
and the Concordance View.   The concordance files contain no text themselves, but they enable 
Musaios to construct the Concordance View on the fly by reading lines in the corresponding TLG-
E or PHI 5.3 CD-ROM text. 
 
For your evaluation, the plug-ins for [Longinus] Rhet. (TLG-E) and Tibullus (PHI 5.3) are 
included in the Musaios download from the Internet.   They are automatically copied to your 
hard drive when you install Musaios and are immediately available.  
 
To switch to the Concordance View, open any work by the author you are interested in as 
described in the section above.  Then from the View menu, choose Concordance View.  If 
the concordance file for the author has not been installed, the item will be grayed. 
 
The Concordance View may be navigated using the same techniques as are used for text 
files.  The screen is divided into two halves with a blank stripe down the middle.  The 
alphabetized words are at the right edge of this central stripe and the following context is 
immediately after.  Where there is a line break, a few extra spaces are added so the structure of 
poetry remains visible.  More of the preceding or following context can be seen by dragging the 
horizontal scroll bar at the bottom of the screen to the left or right (or using the left- or right-arrow 
keys). 
 
The pointer on the Concordance View screen occupies the blank stripe at the center of the 
screen.  The location pointed to is shown at the bottom left of the screen.  You can move the 
pointer with the up or down arrow keys. 
 
You can jump within the Concordance View to a specific word or phrase using the Move To a 
Different Word in Concordance View… item, which appears both on the View menu and Jump 
menu when you have a concordance view open. 
 
You can return to the normal view of the full text by choosing one of two options from the View 
menu.  "Text View (No Repositioning)" returns you to exactly where you were in the text before 
switching to the Concordance View.  "Text View (With Repositioning)" will cause the Text View to 
move its position to that point matching the pointer in the Concordance View. 
 
Just as in the Text View, you can select and export text from the Concordance View.  
Location markings will be added for each line.



 
XIV.  SEARCHING A SINGLE TEXT 
 
Beginning with Musaios 2001 A, the FIND option on the SEARCH menu searches the entire 
work you are viewing.  You can then move backward and forward instantly through the 
search results.  The FIND NEXT item and FIND PREVIOUS items take as their starting point the 
point you are viewing in the file. 
 
The search string may contain embedded spaces if you are looking for a phrase.  When 
you are prompted for a search string, you are also given the option to set the "Search Mode".  
The effect of the Search Mode can be illustrated by example:  Suppose you are searching for 
the word "wife".   The word "midwife" will be found if the Search Mode is set to SUFFIX or 
ANY.  The word "wifely" will be found if the search mode is set to PREFIX or ANY.  If the 
mode is set to EXACT WORD, only the word "wife" will be found.  The word "wife" will in 
fact always be found in all four search modes. 
 



XV.  SETTING UP A MULTI-TEXT SEARCH 
 
If you wish to search the entire corpus of an author, or more than one author, use the 
CREATE SEARCH SPECIFICATION item on the SEARCH menu.   The first thing you must do 
is select the authors you want to search.  Highlight them one at a time in the "combo box" on the 
left, and click on the Add button.  If you make a mistake, highlight the author you don't want in the 
box on the right, and click on the Remove button.   There is an Add All button which will add 
all authors quickly.  This feature is now enabled for the TLG discs as well as PHI.  But 
there are so many authors you may want to use the TLG word index instead (see section 
XIX).  For each of the three CD-ROMs you may save a permanent default list of favorite 
authors.   Use the Save as Default List button. 
 
It is easy to search a subset of your permanent default author list.  You may highlight only 
a few authors (or only one) in the right-hand list by clicking on those of immediate 
interest, and only those authors will be searched.  If no authors are highlighted, all authors in 
the right-hand list will be searched.  The Deselect Highlighted Authors button may be used to 
bring about this condition if some of the authors are selected.  You can also deselect individual 
authors by clicking on them again.  If they are highlighted the highlighting will be cleared. 
 
Once you have picked your authors, you are ready to enter the search string and search mode.  
The same screen is displayed as in the case of "Searching a Single Text" described above, and 
the search modes work in the same way.  
 
Once the search has begun, it is conducted in background.  You are free to open new text 
windows, including the text currently being searched.  You can also "minimize" Musaios 
and use other applications in Windows while the search proceeds.  When the search 
completes, you will hear a single "beep".  The status bar at the bottom of Musaios's main 
window shows the work currently being searched, and the percentage of the work searched so 
far. 
 
To view results as they come in, click on the Results button.  You will be switched to the 
Results screen.  The upper left corner of the Results screen summarizes the search and its 
progress so far.  As incidences of the word arrive, the author, work, and number of occurrences 
found so far are displayed in the right hand listbox.   
 
To display the text for an occurrence on the Results screen, highlight the author and work 
of interest in the right-hand listbox and then click on the Show Text button.  A complete 
location reference and three lines of text will be displayed at the bottom of the screen.  The 
Next and Previous buttons can be used to look at other occurrences in the same work.  If an 
occurrence especially interests you, you can use the Full Window button and the text will be 
displayed exactly as if you had opened up a text window and jumped to the location of the search 
word.   
 
Once you have opened up a text window from the Results screen, you may use the FIND 
NEXT and FIND PREVIOUS items on the SEARCH menu to look at earlier and later 
occurrences without having to return to the Results screen.  If you do wish to return to the 
results screen, use the SEARCH RESULTS item on the SEARCH MENU.  To return to the 
Search Specification screen, use the CREATE SEARCH SPECIFICATION item on the SEARCH 
menu.  For each of the four CD-ROMs, your most recent list of search results are saved on 
the hard disk automatically.  You may exit Windows and turn off your computer, but the 
next time you enter Musaios and go to the Results screen, your last results list will be 
displayed. 
 



 
XVI.  ADVANCED SEARCHING 
 
Version MUSAIOS 2002 A includes two features for performing advanced searches:  
wildcard and Boolean searching, both of which are discussed in this section.  The 
techniques described here can be used in conjunction with the basic search mode options 
described above.  Since no current search program has any understanding of morphology or 
grammar, it is necessary to provide other means, such as wildcard and set matching to find all 
occurrences of a given word.  To match a single character at any point in the search string, 
type a '?' in the string.  Please note that multi-character wildcards ('*') are not yet supported.  
Also, a set of characters may be specified at any point in the search string.  To use this 
feature, enclose the character set in square brackets ('[' and ']').  Ranges may be specified 
with a dash (e.g. '[a-y]' will match all letters from 'a' to 'y', but not 'z').  Character sets are useful 
when looking for words which may have a long or short vowel depending on dialect or a 
constrained set of characters depending on tense or case.  The question mark can also be used 
in these instances and will find the desired words but may also find many unwanted words.  If the 
caret ('^') is the first character of the set, any characters not in the set will be matched.  For 
example 'di[ae]' in the search string will match 'dia' and 'die' but not ''dio' in the text.  In contrast, 
the search string 'di?' will match 'dia', 'die', and 'dio', in other words, 'di' followed by any character.  
The opposite effect can be obtained with the search string 'di[^ae]' which will cause 'dia' and 'die' 
not to be found, but will match 'dio' and any other string beginning with 'di' without an immediately 
following 'a' or 'e'. 
 
It is often useful to search for words near each other in a text, without being an exact phrase.  For 
this purpose Musaios supports four Boolean operators, OR ('||'), AND ('&&'), AND THEN 
('&<'), AND NOT ('&!').  Any of these operators may be inserted between two expressions 
in the search string.  At this time only two Boolean terms are supported;  this will be expanded 
in future versions.  The OR operator matches any place in the text where either one or both of the 
terms connected by the OR operator occur;  note that this is not an exclusive OR;  the OR 
operator will match places in the text where both words occur.  The AND operator matches any 
place in the text where both of the terms connected by the AND operator occur, regardless of the 
order of the two terms in the text.  The AND THEN operator matches any place in the text where 
the first term occurs in the text followed by the second term.  The AND NOT operator matches 
any place in the text where the first term occurs without the second term.  The default vicinity 
used by the Boolean operators is 100 characters, i.e., the effect of the Boolean operator 
extends only 100 characters from the first term.  It is possible to set this by using the '#' 
character followed by a decimal number (e.g. 300).  The preferred location of this option is 
immediately following the Boolean operator (e.g. '&<#250'). 
 



Summary of all special search characters: 
&& AND operator finds passages with the two words in proximity, in any order. 
&! AND NOT operator finds passages with the first word when the second word is not in 

proximity. 
&< AND THEN operator finds passages with the first word and the second word in 

proximity after the first word. 
|| OR operator finds passages with either or both of the two words. 
#n sets proximity to n characters (default = 100). 
\< at the beginning of an expression sets search mode to PREFIX, thus matching the 

expression only at the beginning of a word.  Using both this and the following 
operator has the effect of setting the search mode to EXACT. 

\> at the end of an expression sets search mode to SUFFIX, thus matching the 
expression only at the end of a word.  Using both this and the preceding operator has 
the effect of setting the search mode to EXACT. 

[] creates a character set and matches any characters within the set.  Ranges may be 
specified using a dash (e.g. [1-9] will match all digits except 0’). 

[^] creates a character set and matches any characters not within the set. 
? matches any single character. 
 
In this version the above characters will not be displayed correctly while typing search 
strings in Greek characters.  Type the above characters on the keyboard regardless of the 
screen display.  This problem will be fixed in a future version, but it did not seem worth delaying 
the introduction of Boolean searching to fix this display problem. 
 
Examples: 
"dog||cat" will find any passages containing the word "dog" or the word "cat",  or both words, in 
any order. 
 
"dog&&cat" will find any passages containing the words "dog" and "cat", in any order, within 100 
characters (the default) of each other. 
 
"dog&<#250cat" will find any passages containing the word "dog" followed by the word "cat" 
within 250 characters. 
 
"dog&!#175cat" will find any passages containing the word "dog" without the word "cat" within 
175 characters before or after the word "dog". 
 
If the above examples were run with the search mode set to ANY, words in the text such as 
"dogs", "cats", and "catapult" would all have been matched as well.  In order to control this 
behavior search modes must be specified. 
 
"dog\>&&cat\>" will find any passages containing the word "dog" (but not "dogs") and the word 
"cat" (but not "cats" or "catapults"), in any order, within 100 characters (the default) of each other. 
 
In the preceding example, the word "scat" would also have been matched by the second term.  
The search can be narrowed as follows: 
 
"dog\>&&\<cat\>" will find any passages containing the word "dog" (but not "dogs") and the word 
"cat" (but not "cats", "catapult", or "scat"), in any order, within 100 characters (the default) of each 
other. 



XVII.  USING THE TLG WORD INDEX 
 
To select the TLG Word Index screen, use the TLG WORD INDEX item on the FILE menu, 
(For convenience the item also appears on the SEARCH menu.) 
 
The TLG Word Index screen in appearance and operation closely resembles the Results 
screen described above, except for the upper left corner, where there is a listbox which 
contains every form of every Greek word in every text on TLG CD-ROM D.  You may select 
a specific portion of the alphabet by typing in the Greek text.  Whenever you stop typing 
for one second, the listbox repositions itself.  You may also drag the scrollbar thumb in 
the standard Windows fashion to move through the list.   
 
When you have found the word form you want, click on the Show Works button to fill the right-
hand listbox with a list of authors and works.  Note that to save disk space, the TLG Word Index 
files specify works by work number only and not by name.  Therefore Musaios displays only the 
work number, since the time required to fetch and display the name of each work would make the 
index prohibitively slow. You can use the TLG Canon of Greek Authors and Works to determine 
the names of the works.   
 
Text for each citation is displayed in the same way as for the Results screen described above.  
However, the TLG Index files do not contain location information for each word -- only a list of 
authors and works.  So once a text is selected for display, further searching must be done.  You 
will be shown a progress box with a cancel button. 
 



XVIII.  USING THE TLG CANON LISTS 
 
To select the TLG Canon Lists screen, use the TLG CANON LISTS item on the SEARCH 
menu.  These are various lists of authors and works, selectable by literary classification, 
chronologically, by epithet or genre, geographically, etc.  You will want to explore these 
lists in designing your searches.  You can now easily search the authors that you select 
via these lists. 
 
Furthermore, the authors on each of these lists can be ordered by TLG number, or 
chronologically, and include or exclude the authors not included on the latest CD-ROM.  When 
you enter the TLG Canon Lists screen, you will see that you can select the ordering by TLG 
number or chronologically using the upper of the two listboxes, and can select the list criteria 
(geographical, women writers, epithet or genre, etc.) using the lower one.   Once you have made 
your selections, you may click on the View Contents button and you are moved to the next file tab 
in the folder.  On this screen, you see the categories in the list in the left listbox, then pick out the 
lists you are interested in.  You may click on Display to add the authors and works in the list to 
the right listbox (the existing contents of the right listbox will be erased).  Or you may click on Add 
to retain the present authors in the right listbox and add some more from a new list.  To remove 
authors you may click on individual ones and choose Remove, or clear the list entirely with 
Remove All. 
 
Once your right listbox contains a list of authors that you are ready to search, click on Search 
These.   You will be moved to the Multi-Text Search screen described in section XVII above, and 
you will see your authors in the right listbox of that screen. 
 
At this point in the evolution of Musaios, entire authors are always searched, not individual works, 
even if the list you were viewing specifies individual works.  This refinement will be addressed in 
a future release. 
 



XIX.  THE TOOLBAR 
 
Once you are familiar with the menu system, learn the toolbar equivalents: 
 
   1    2    3    4            5    6     7      8     9   10  11    12   13  14  15    16  17    18   19  20   21 

 
From left, these symbols equate to: 
 
 MENU  ITEM 
 
1. FILE  OPEN 
2. EDIT  COPY  
3. FILE   PRINT  
4.    [Reserved for future use] 
 
5. SEARCH  FIND PREVIOUS 
6. SEARCH FIND 
7. SEARCH  FIND NEXT  
 
8. JUMP  BEGINNING OF THIS WORK 
9. JUMP  GO BACK 
10. JUMP   JUMP 
11. JUMP  END OF THIS WORK 
 
12. WINDOW CASCADE 
13. WINDOW TILE VERTICALLY  
14. WINDOW TILE HORIZONTALLY 
15. WINDOW NEXT WINDOW 
 
16. WINDOW CLOSE 
17. WINDOW CLOSE ALL 
 
18. SEARCH CREATE SEARCH SPECIFICATION 
19.  SEARCH  SEARCH RESULTS 
20. SEARCH TLG WORD INDEX 
 
21. HELP  ABOUT 
 
 
XX.  ACCELERATOR KEYS 
 
For almost all of the menu items, there are function key and control key equivalents.  
These are listed to the right of each menu item throughout the menu system. 
 



 
XXI.  BETA CODE 
 
"Beta Code" is a simple standard for representing Greek text by Latin letters.  You may enter 
unaccented search strings in Musaios in beta code, or you may use the Polytonic Greek 
keyboard built in to Windows [once you have installed it as described in section VII above], as 
you wish. 
 
Alpha  A          Nu             N   
Beta       B          Xi              C   
Gamma  G          Omicron   O   
Delta       D          Pi              P   
Epsilon  E          Rho           R   
Zeta        Z          Sigma        S   
Eta          H         Tau            T   
Theta      Q         Upsilon      U   
Iota          I           Phi            F   
Kappa     K         Chi            X   
Lambda  L          Psi            Y   
Mu          M         Omega      W 
 
 
 
 
XXII.  DE-INSTALLATION OF MUSAIOS 
 
From the Start Menu (normally launched by the button at the far lower left of the screen), select 
the Settings item, then choose Control Panel.  From the Control Panel, launch the Add/Remove 
Programs applet.  Scroll down through the list of programs, select Musaios, then click the 
Add/Remove Program item.  After you confirm that you want to remove Musaios and all its 
components, full removal will proceed automatically. 
 



 
XXIII.  IN CASE OF PROBLEMS: 
 
We have inspected a fair number of texts, but nonetheless there are likely to be problems with 
some of the texts we haven't looked at yet, especially on PHI 7.  If you find a problem, it is 
most important that you record AUTHOR (or COLLECTION), WORK, and ALL LOCATION 
INFORMATION, and include them explicitly in your report to us.  This will maximize your 
chance of getting it fixed quickly. 
 
We solicit all kinds of comments, including comments on "merely aesthetic" matters to help us set 
priorities as we plan our work for future releases. 
 
The preferred method of correspondence is by Internet E-mail.  Contact: 
 
DARL J. DUMONT at ddumont@musaios.com 
 
You may also write to the project's business address listed at the beginning of this document.  
 
Due to the fact that we work full-time jobs not related to the Musaios Project, it is impossible for 
us to receive phone calls at home or at work. 
 
 
XXIV.  LEGAL NOTES AND DISCLAIMER: 
 
After receiving a copy of MUSAIOS from whatever source, you must register and pay within 30 
days, or else de-install the product from your computer and cease using it. 
 
IN NO EVENT WILL THE AUTHORS OF MUSAIOS (DARL J. DUMONT AND RANDALL M. 
SMITH) BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING WITHOUT 
LIMITATION DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION AND THE LIKE) ARISING FROM THE USE OR THE 
INABILITY TO USE THIS PRODUCT, EVEN IF THE AUTHORS HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. 
 
 
MusaiosTM is a trademark of Darl J. Dumont and Randall M. Smith. 


